
Communicate: SymWriter

Please write your registration number here. 
You may need it in the future.

 
                                                                                

When you register your product, please enter your email address to be informed of FREE 
program updates, help sheets and downloadable resources. You can also get this information 
at www.widgit.com/symwritersupport



Communicate: SymWriter © Widgit Software 2007 
Published by Widgit Software

Widgit Literacy Symbols © Widgit Software 2004-2007 

A statement about the copyright conditions for using the Widgit Literacy Symbols (WLS) is 
included in Appendix 2 Copyright p119 of this manual.

These conditions also apply to the use of
Picture Communication Symbols (PCS) © Mayer-Johnson LLC in the UK. 

Widgit Software is a brand of Logotron Ltd

Part number: SYMWRI2

Documentation version 1.00

Widgit Software
1st Floor
Bishops House
Artemis Drive
Tachbrook Park
Warwick
CV34 6UD
United Kingdom
Tel:  +44 (0) 1223 425558
Fax: +44 (0) 1223 425349



Communicate: SymWriter User’s Guide

�

Contents
Introduction 7

What is SymWriter								  7
Using this guide								 7
Typical writing screen							 8
Environment designer screen						 9

A. Writing into the document 11

A1. Starting the program								 11

A2. Symbolising what you write						 12
A2.1 Using the smart symboliser						  12
A2.2 Changing the symbol from the symbol chooser			 12
A2.3 Changing the words for a symbol					 13
A2.4 Changing the image on a word					 14
A2.5 Changing the colours in a symbol					 15
A2.6 Skin tones								 16
A2.7 Switching between colour and monochrome			 16
A2.8 Changing properties of the whole document			 17
A2.9 Qualifiers								 18
A2.10 Symbol sets								  20
A2.11 Languages								 20

A3. Text and symbol formatting						 21
A3.1 Changing font								  21
A3.2 Changing the font and symbol size together			 21
A3.3 Changing the symbol size						 22
A3.4 Changing the graphic size						 22
A3.5 Paragraph alignment, word and line spacing			 23
A3.6 Tabs 24
A3.7 Bullets									  24
A3.8 Indents									  24
A3.9 Aligning									 25
A3.10 Text position								  25
A3.11 Text colour								 26
A3.12 Line colour of symbols						 27

A4. Writing in text									 28
A4.1 Writing in text								  28
A4.2 Seeing the meaning – the symbol chooser				 28
A4.3 Mixing symbol and text writing					 29
A4.4 Marking verbs and nouns						 29

A5. Putting in pictures								 30
A5.1 Adding pictures – the graphics browser				 30
A5.2 Aligning									 32
A5.3 Finding symbols							 33
A5.4 Storing your own pictures						 33



Communicate: SymWriter User’s Guide

�

A6. Screen layouts									 34
A6.1 Page presentation							 34
A6.2 Zooming								 34
A6.3 Page navigation							 35
A6.4 Page set-up, margins and paper colour				 35

A7. Saving and opening documents						 36
A7.1 Auto-saving 36

A8. Printing										 37

A9. Speech										 38
A9.1 Speech on demand							 38
A9.2 Auto speech								 38
A9.3 Voice selection								  39
A9.4 Setting Sapi4 voices							 39

A10. Spelling									 40
A10.1 Marking errors							 40
A10.2 Using the simple checker						 40
A10.3 Using the full checker							 41
A10.4 Deleting extra ‘correct’ words					 42
A10.5 Adding extra spelling suggestions					 42

A11. More advanced features							 43
A11.1 Wordlists								 43
A11.2 Loading a Topic wordlist						 44
A11.3 Setting a default Topic wordlist					 44
A11.4 Saving symbol changes 45
A11.5 Transferring wordlists and graphics					 46
A11.6 Choosing how to symbolise 						  47
A11.7 Creating an empty topic wordlist					 47



Communicate: SymWriter User’s Guide

�

B. Writing with grids								        48

B1. Examples of what you can do						      49
	 B1.1 Example files								        49

B2. Making a grid									         51 
	 B2.1 Starting in Design-mode						      51
	 B2.2 Choosing the layout of a grid						      52
	 B2.3 Highlighting cells							       53
	 B2.4 Moving and resizing							       53
	 B2.5 Moving cell boundaries						      54
	 B2.6 Merging cells								        54
	 B2.7 Breaking up cells							       54
	 B2.8 Putting in content							       55
	 B2.9 Tidy cells function							       56
	 B2.10 Expand to fit								        57
	 B2.11 Rows and columns							       57
	 B2.12 Simple cell actions							       58
	 B2.13 Testing a grid								        59
	 B2.14 Grid appearance							       60
	 B2.15 Altering the appearance of a stage					     62

B3. Environments									         63
	 B3.1 Documents and Environments						     63
	 B3.2 Saving and Opening environments					     64
	 B3.3 Templates								        64
	 B3.4 Editing an environment from write-mode				    65

B4. Linked grids									         66
	 B4.1 Auto linked grids							       66
	 B4.2 Making a sequence of linked grids					     68
	 B4.3 Using two separate grids						      72
	 B4.4 Storing information about a grid					     76
	 B4.5 Miscellaneous								        76

B5. Using actions									         77
	 B5.1 Basic actions								        77
	 B5.2 Range of actions							       78
	 B5.3 Example showing how to send picture				    80
	 B5.4 Changing actions in multiple cells					     81
	 B5.5 Sound feedback in cells						      81

B6. Tray and buttons								        82
	 B6.1 What is a tray - overview						      82
	 B6.2 Making a single tray							       82
	 B6.3 Altering the appearance of a tray					     86
	 B6.4 Linking trays								        87
	 B6.5 Using buttons direct on a stage					     87
	 B6.6 Using multiple stages							       88



Communicate: SymWriter User’s Guide

�

B7. Switch scanning								        90
	 B7.1 Setting up switch scanning						      90
	 B7.2 Types of switching							       91
	 B7.3 Auditory Scan								        92
	 B7.4 Setting what happens after selection (regular grids)		  93
	 B7.5 Setting the scan order							       94

C. Preferences and toolbars							       95

Overview										          95

C1. Start up preferences								        96
	 C1.1 Start appearance							       96
	 C1.2 Colour setting								        97
	 C1.3 Text/graphics								        97
	 C1.4 Symbolisation								        98
	 C1.5 System									         98
	 C1.6 Graphic locations							       99
	 C1.7 Speech and spelling							       99
	 C1.8 Symbol source								        100

C2. Toolbars										         101
	 C2.1 Changing the toolbar buttons and layout				    101
	 C2.2 Changing your default expert interfaces				    103
	 C2.3 Creating and editing interfaces					     104
	 C2.4 Adding an interface button to the launcher				   105
	 C2.5 Creating a personal desktop link for an interface			   106

D. Symbols										          107

D1. Issues of symbolisations							       107

D2. Five golden rules								        108

D3. The Widgit Literacy Symbols						      110

E. Glossary										          115

Appendix 1 Location of files							       117

Appendix 2 Copyright								        119



Communicate: SymWriter User’s Guide

�

Introduction

What is SymWriter?

SymWriter is a tool designed to help students and older people who have difficulty writing 
text. This includes students in primary school who are struggling with literacy, pupils in special 
schools and adults with a learning disability, including acquired problems. It is the modern 
successor to Widgit’s ‘Writing with Symbols’.

SymWriter can also help teachers and carers produce symbol supported literature for display 
and other purposes. Widgit also have more sophisticated software for those who require 
more elaborate layouts – see www.widgit.com/inprint

Users with a measure of text ability may choose to write using the keyboard. Automatic 
symbolisation gives immediate feedback on the meaning of the word whether symbols are 
chosen to be visible in the main writing document or not. There is speech support and a spell 
checker with symbol support.

The symbolisation uses Widgit’s new ‘smart symbolising technology’. This is designed to 
increase the accuracy of symbolisation, analysing the grammar of the sentence and so 
choosing the symbol that illustrates the correct part of speech.

Those for whom text is more difficult may write by selecting cells which display symbols. 
Selecting a cell can send the contents of the cell to the writing document. You can see a 
screen layout showing a typical writing screen on p8.

To create larger vocabularies, grids of cells can be linked to access more words and phrases. 
Cells can also be selected by switch users with a range of scanning options. Sets of grids and 
buttons used for writing are called Environments which can be created by the teacher. A 
screen showing a typical layout in the Designer is shown on p9. 

Using this guide

This guide is divided into two main sections. The first describes the features of the writing 
document, and the use of the symboliser. The second shows how students can write from 
grids and the way that the grids can be created.

Each sub section has a main topic with short, easy to follow instructions for the relevant 
features. Those who are familiar with Writing with Symbols or Communicate: In Print will 
find many similarities. In this guide the word teacher will be used to mean a teacher, carer or 
parent who is using the program to create and edit activities. Student will be used to mean 
the person who uses the grids or the writing tools. Terms which are underlined have specific 
meanings in SymWriter. They are explained in the text, but also are described in section E. 
Glossary p115.
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Users toolbar, chosen 
from the launcher.

Tabbed bar to select the 
Symbol chooser or 
Graphics Browser.

Symbol chooser 
displays the 
alternative 
symbols for the 
typed word. 
See p12

Document

Grid with cells 
that can be 
selected.

A tray with command graphics. In 
this example the graphic and text 
are set to the document.  

A linked grid, which can 
change the available 
vocabulary.

Buttons that can 
perform Actions.

Graphics Panel 
used by teachers 
and students to 
change the image 
for a word or to 
add graphics in a 
document. See p30

Typical writing screen - Showing terms used in the program
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Designer toolbar.

This Tabbed bar has more 
options in design-mode.

Grid viewer 
showing all the 
grids and trays in 
the environment.

Document.

Grid.

Cell (highlighted). Button.Tray with 
background.

Command graphic.

Symbol Chooser
Used by teachers and 
students to pick the best 
symbol. See p12.

Graphics Browser
Used by teachers and students to 
change the image for a word, or 
add graphics in a document.
See p30.

Grid Viewer
Used by teachers only for 
managing and linking 
grids. See p66.

Environment designer screen - Showing terms used in the program
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Important Note

A copy of this documentation in pdf format is available by selecting the Help menu and 
choosing View on-line help (or press F1). It is also possible to produce the documentation by 
selecting the Pdf manual button from the launcher, p11.

This means that you can have access to the manual at any time and you can print more copies 
of the documentation for your own use if you wish.
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A. Writing into the document

A1. Starting the program

When you start the program you will get the launcher. This normally appears as below (If you 
are logged on as a student the bottom row of buttons may not appear). This allows you to 
choose the type of interface for a student to use, or the type suitable for teachers.

Click on one of the coloured buttons when students use the program. 
The buttons give different levels of interface - the easiest on the left.

Click here to launch 
the program with 
the full interface to 
create documents to 
print. (Part A of this 
documentation).

Extra icons may 
appear here if you 
design your own 
interfaces.

Click here to go to 
extra information, free 
updates and resources 
for SymWriter at, 
www.widgit.com.

Click here to launch 
a pdf file of the 
documentation.

Click here to use the 
designer for creating 
Grids etc. Grids are 
for students to use to 
write. (Part B of this 
documentation).

N.B. The coloured buttons are designed to give degrees of simplified interface and 
more limited functionality. If you select one of these when reading this part of the 
documentation you may find that some features are unavailable. In section C2 p101 
you will see how to configure and create new interfaces to your own specification.

All buttons except Design environment put the program in write-mode where the 
purpose is to write a document (with or without the help of grids). Selecting Design 
environment puts the program in design-mode, used for creating grids and other writing 
support.

To follow Part A of this documentation select the Write Document button to put the 
program in write-mode. 
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A2. Symbolising what you write

A2.1 Using the smart symboliser

Start the program using the Write document button 
on the launcher. Type “Drink your drink” watching 
what happens. As soon as the symboliser has enough 
information to realise the first word is a verb it 
changes the symbol. 

Try typing other sentences.

A2.2 Changing the symbol from the symbol chooser

Type “I work with computers”.

1. Click in the
word “work”.

2. Click here to show
the symbol chooser.

3. Click to select the
symbol that is best for
your meaning.

Click here to turn the 
symbol off.

Where there is more than one symbol that makes grammatical sense you can choose the 
best from the symbol chooser. Or you can press the F9 key to cycle through the alternatives, 
including ‘symbol off’. You can also turn a symbol off by clicking on the Symbol off icon in 
the symbol chooser. Within this writing document the program will remember your choice 
when you next type the same word.
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A2.3 Changing the words for a symbol

Type “My cat is named cat”.

Click on “cat” and press the F11 key, then type “whisky” and 
press the right arrow key to move the cursor out of the symbol.

Change Symbol text.

Now press the Enter key (return), and type “and whisky is my cat”.
Also try starting with “My cat is called whisky” and make the symbol for “called” the correct 
one. You can press the Change Symbol text icon, if it is on your toolbar, as an alternative to 
pressing F11.
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A2.4 Changing the image on a word

Type “There’s a rabbit in my garden”.

1. Click on the 
Graphics tab to 
show the Graphics 
browser.

2. Scroll down until 
you can see the 
photos folder.

3. Click once on the 
photos folder to 
show the contents.

4. Click on the 
over-write 
symbol icon.

5. Click on the 
photo of the rabbit, 
and then on the 
symbol for rabbit 
in the document. 
There is no need to 
drag.
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A2.5 Changing the colours in a symbol

Type “I bought a soft green jumper.” You will see that the symbol for the jumper is red.

1. Click in the word 
“jumper” and then on 
the colour graphic icon 
from the toolbar.

2. Click on the red colour 
you want to change.

3. Click on the green colour (or choose 
a different user colour by selecting the 
appropriate icon). Do this for all the 
colours you want to change. 

4. Now use the F11 key 
to change “jumper” to 
“green jumper”. Then 
delete the superfluous 
“green” symbol. 
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A2.6 Skin tones

Symbols which contain skin colour can have the skin tone changed. Type “The girl is happy”.  
Press CTRL + A to highlight everything.

etc...

Now press the skin 
tone icon on the 
toolbar and see the 
tones change.

Press the colour button to 
toggle between symbol 
colour on or off, for either 
highlighted words, or for 
the symbol where the 
cursor is.

A2.7 Switching between colour and monochrome

Type a sentence that shows coloured symbols, e.g “The elephant hid behind the tree.”

The skin tone icon works on highlighted 
text, or on the symbol where the cursor is.
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A2.8 Changing properties of the whole document

You can change the way symbols appear in the whole of the main document. Also you can 
control these properties in the stages (p51) that hold the grids for writing. From the Symbols 
menu select Symbol display…

Select whether you want symbols 
in colour or monochome, or if you 
want to, leave the current settings 
unchanged.

Select whether you want 
symbols on or off, or if you 
want to, leave the current 
settings unchanged.

Click here to apply 
to everything.

Select the skin tone, 
or if you want to, 
leave the current 
settings unchanged. 
Click in the radio 
button under the 
colour you want.

Click on this button to 
select the line colour 
of symbols, or if you 
want to, leave the 
setting unchanged.

Click here to 
apply the settings 
to the document.

Click on any 
stages where you 
want the settings 
to operate.

If you open the symbol display when you are in the designer, you will have an extra section 
to set the display on stages as well as the document. The grey areas show the position of the 
stages.
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A2.9 Qualifiers

A symbol may have a qualifier to indicate plural, a verb tense, a comparative or superlative.

These can be switched on or off for (A) the current symbol, or for (B) the whole document or 
stage.

A. Locally, for the current symbol

N.B. This also works over any highlighted section of text.

There are also toolbar buttons for these options on the default teachers writing toolbars.

Past
tense

Plural

Comparative and 
superlative

1. Right button click in a 
word where you want to 
switch the qualifier off 
(or on).

2. Select the appropriate 
menu item to change 
to make the qualifier 
invisible (or visible).
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B. More Generally

Select the Symbols menu then Qualifier Display… 

If you only have a Writing 
Document you do not see the 
representation of any stages. 

If you are in the Environment 
Designer and have stages you 
may also select  the stages you 
want this to apply to.  

2. Click here if you want to 
change everything. Then click OK.

3. Click on the stage(s) where 
you want this to apply.

4. Click here if you want this to 
apply to the whole writing
document. 

1. Select which qualifiers you 
want to change.

NB The selecting Stages 
tool is only available in 
Environment Designer 
mode when you have 
stages setup.
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A2.10 Symbol sets

The program is supplied with the Widgit Literacy Symbols (WLS). If you have purchased the 
Picture Communication Symbols (PCS) as an add-on then you have the choice between symbol 
sets. In this case you can choose between WLS and PCS. Make this choice from the Symbols 
menu Symbol set… These symbol sets are described in Appendix 2 Copyright p119.

The default symbol set can be set from the Preferences menu. From the Tools menu select 
Preferences. In this dialog box, there are some additional tabs that are hidden when the box 
opens. Click on the little right arrow to scroll to the additional tabs.

A2.11 Languages

If you have purchased the appropriate databases you can use SymWriter in other languages. 
Just go to the Symbols menu and select Languages… A list of languages will be seen. Those 
for which there is no database will be shown greyed out, i.e. not selectable.

Changing the language does not change the interface. The toolbars and menus remain in 
English, but the symbolisation, speech and spell checker will change to the selected language.

Scroll to select the Symbol source tab.
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A3. Text and symbol formatting

Reminder:
There are a variety of toolbar arrangements supplied with the program to deal with users 
at different levels. Not all functions are available on any particular arrangement. In this 
section we show a range of toolbar buttons that can be used. It is possible to make your own 
arrangement of toolbars as described in section C2 p101. If you enter the program through 
the Teachers’ Write document button on the launcher, then most of the toolbar icons in this 
section will be available.

A3.1 Changing font

The font is most easily changed using the font toolbar. Highlight the section you want to 
change then use the toolbar.

Some toolbar arrangements may have the following alternative for controlling font size.

Bold Underline Shadow

ItalicsFont size.Font face name.

These buttons allow you to increase or 
decrease the font size.

Increase or decrease size of font and 
symbols together. 

A3.2 Changing the font and symbol size together

The font and symbols can be increased or decreased in size together. This makes formatting 
easier for beginner writers. 
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A3.3 Changing the symbol size

The symbol size can also be set for highlighted text or at the point where the cursor is by 
using the Symbol Size selector.

You can also use the symbol size dialog to change the symbol size for either the current 
symbol of the whole document. From the Symbols menu select Symbol size.

Some toolbar arrangements may have the following alternative for controlling symbol size.

Select size here, or 
type in your own 
value.

Click here 
to apply to 
the whole 
document.

Click here 
to apply to 
graphics to be 
dropped in 
‘loose’. See p30.

Click here to apply 
to current symbol, 
or highlighted 
symbols.

These buttons allow you to increase or 
decrease the symbol size.

Select a symbol size from this drop down box.

A3.4 Changing the graphic size

Graphics that are dropped into a document as illustrations have their own size setting. Whilst 
you are working, the size of the graphic can be set in advance in the Symbol Size dialog 
shown in A3.3 Changing the symbol size. Afterwards you can click on the graphic to show the 
drag points and re-size it manually.

You can also set the default size in the Preferences dialog under the 
Text/Graphics tab.

	
	 Inserting these ‘loose’ graphics is described on p30.
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A3.5 Paragraph alignment, word and line spacing

You can choose to alter the horizontal spacing between words or symbols. You can also alter 
the spacing between lines, and add extra space between paragraphs. These extra spaces are 
called leading (pronounced ‘ledding’). As you make changes in this dialog box you will see 
the effects of these changes immediately. Click on the Text menu and select Paragraph...

You can use the settings 
in the top half of 
this box for functions 
described elsewhere.

Use this to change 
the horizontal 
spacing between 
words or symbols.

Use this to change 
the vertical spacing 
between lines.

Use this to 
change the extra 
spacing between 
paragraphs.

Click this button if you 
want these settings to 
apply to future use of 
the program.

Use this to say if the 
changes apply to the 
whole document or just 
the current paragraph.
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A3.6 Tabs

There is a very simple method for setting tabs. It is possible to change the number of equal 
tab settings across the screen. Go to the Text menu, and then select Paragraph. This will 
bring up a dialog. Select Tabs from the top. 

Choose whether 
you want the 
setting to apply 
to the current 
paragraph or the 
whole document.

Click this button to 
save the setting for 
future use of the 
program.

Click one of these 
buttons to set the 
number of tabs 
across the screen.

Click to increase 
the paragraph 
indent.

Click to decrease 
the paragraph 
indent.

A3.7 Bullets

To apply bullets to any paragraph (or highlighted set of paragraphs), simply click 
the bullet icon to switch the bullets on and off.

A3.8 Indents
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A3.9 Aligning

Text in paragraphs can be aligned left, centre or right using the 
standard icons.

Text on top icon.

A3.10 Text position

You can choose whether to see the text above or below the symbols. This can be set on a 
per-paragraph basis. Click in the paragraph (or highlight the paragraphs) that you wish to 
change. To put the text above the symbols choose the Text menu and select Text above 
symbols. If the text is already above the symbols then from the Text menu select Text 
below symbols. 

You can also set the default position using the start-up options described in section C1. Start-
up preferences.

There is a toolbar icon which you can add to your toolbars if you regularly want to use this 
feature. Section C2. Toolbarsdescribes how to change the toolbars.
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Font Colour icon.

Click any colour 
button to choose 
the text colour.

Click here to define your own colour.

Click OK to 
change the 
colour of the 
highlighted text.

A3.11 Text Colour

You can change the text colour for any highlighted text. You can bring up the colour dialog 
box from the colour button or from the Text menu select Colour... The dialog will only 
appear if the cursor is in some text.



Communicate: SymWriter User’s Guide

27

A3.12 Line colour of symbols

You can change the line colour of symbols. This is most useful with monochrome symbols to 
assist with visual impairment.

From the Symbols menu select Line colour... The dialog will only appear if you have the 
cursor visible as otherwise there is nothing to apply the changes to.

Click any colour 
button to choose 
the line colour.

Click here to define your own colour.

Click OK to 
change the line 
colour of the 
current symbol, 
or the ones 
highlighted.

You may want to change the paper colour to give a good contrast with the symbol line 
colour. This is especially useful for enhancing the access to readers with a visual difficulty.

The paper colour can be set from the Page Set-up, under the File menu (see section A6.4 
Page set-up, margins and paper colour p35)
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A4. Writing in text

A4.1 Writing in text

To write a paragraph in text without symbols, press the F10 key before 
starting to write in that paragraph. Alternatively if the text/symbol 
button is on a toolbar, then you can use that instead.

Now type and you will see no symbols in the paragraph. Also there will be no space for 
symbols. (You can, however, switch symbols back on for any word - See section A4.3 Mixing 
symbol and text writing).

Click in “voltage” and see 
a symbol that provides a 
reminder of the meaning.

Click in “current” and see 
a symbol that provides a 
reminder of the meaning.

A4.2 Seeing the meaning – the symbol chooser

Students who do not need full symbol support may benefit from seeing the meanings of 
words illustrated either as they write, or by later clicking in a word.

Into a blank document type “Voltage is the 
electrical “push” trying to send the current 
round the circuit”.
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A4.3 Mixing symbol and text writing

Sometimes you want to write largely in text and then switch on a few key symbols. Write 
your sentence in text-mode. Put the cursor in the words where you want symbols, and either 
press the F10 key, or select the symbol from the symbol chooser.

Text only, but click in a 
word to see the meaning.

Start in text, 
then press the 
F10 key to 
continue with 
symbols.

Start in symbols, then press the F10 key 
to continue in text only. If you continue 
to type in text the next line will not 
leave space for symbols.

A4.4 Marking verbs and nouns

It is possible to colour the text for each noun in blue and each verb in red. This works on 
a paragraph by paragraph basis. From the Text menu select Show parts of speech. You 
can then choose to mark the Nouns, mark the Verbs, or Remove marks so setting all text 
colour to black.

You can also put these actions in a grid cell. The way of adding actions is described in section 
B5. Using actions p77. These actions are listed under the Part of speech markings heading 
in the Edit cell actions dialog box.
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A5. Putting in pictures

A5.1 Adding pictures – the graphics browser 

The graphics browser enables you to browse through any pictures on your hard disk and 
some other network places. 

Use this tab to show 
the graphics browser.

Click here to move 
up a directory.

Click once on a 
directory to see the 
contents.

This button accesses 
the Widgit Pictures 
(supplied), and 
when selected they 
are shown in the 
window.

This button accesses 
pictures in an area that 
all users can access.

Click here to see 
the images in the 
My Pictures folder.
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Use the browser to navigate to a picture you want to add. Below we went to the photos 
folder and typed the text shown in the document.

Select this icon to 
put in
a loose 
picture.

Select this icon to
replace a symbol 
with a picture. 
See p14.

Select the picture you 
want to add, and then 
click in the paragraph 
where you want it to 
go. 

If you make a mistake 
and pick up the wrong 
graphic you can get 
rid of it with a right 
button click.

The graphic will be dropped to the left, centre 
or right of the screen, depending where 
you click, and the text will wrap around the 
picture. The next section shows you how to 
change which side the text wraps when the 
picture is in the centre.

You can change the size of the image, and you can also easily put it in a paragraph of its 
own.

Click on the picture 
and use one of the 
lower corner points 
to drag to the size 
you want.

To put the squirrel in a 
paragraph of its own, put 
the cursor before the first 
letter, i.e. before the T of 
“There”,  and press the 
Enter key. 

You could also do this 
by pressing the Enter 
key to make an empty 
paragraph before 
dropping the picture 
into it.

To set the default 
size for a dropped 
in graphic select 
Symbol size from 
the Symbols menu.
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A5.2 Aligning

Graphics can be aligned within a paragraph to the left, 
centre or to the right using the icons shown.

Click on the text 
wrap icon to 
produce the effect 
that you want.

When the graphic is centred, you can also select whether the text wraps to the left or right of 
the picture. From the Text menu select Paragraph…, and then click on the Graphics tab.
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A5.3 Finding symbols 

You may want to find a symbol to use in a document, either to replace another symbol, or to 
put as a separate image in a paragraph.

Click on the Symbol tab on the right hand side to bring the Symbol Chooser to the front. 
At the bottom you see:

1. Type the text for 
the symbol here.

2. Then click on Find 
Symbol.

A5.4 Storing your own pictures

Pictures which are personal to you will probably be stored in the My Pictures subfolder 
of My Documents. On the graphic browser there is a button – My Pictures - which is 
automatically set to browse to this location.

You may also want to share pictures with other teachers. In this case, My Pictures will not 
do, as you will only see pictures here with your own computer log-on. Shared pictures should 
be placed in an area that can be seen and shared by all users of the machine. Such a location 
is within the All Users area of Documents and Settings. By default, SymWriter will use:
C:\Documents and Settings\All Users\Documents\Shared Pictures.

If you want to change the location of either of these areas, then you can do so as described in 
section C1. Start-up preferences.

It is likely that any such changes will need to be discussed with your network manager or IT 
technician.

This is also a useful way to ‘brainstorm’ the symbols available so as to find one that might be 
suitable for a particular word
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A6. Screen layouts

A6.1 Page presentation

There are three ways to display the pages in a document.

Choose the display that suits 
what you want to do.

Page break view 
Shows the pages 
vertically under one 
another with a clear 
division between them.

Print view
Shows one page at 
a time. Pages can be 
‘turned’ forwards and 
backwards.Continuous view 

The document is seen 
as one long document 
without breaks.

Choose the zoom level 
that fits. Fit to width 
makes sure that the 
width of the document 
fills the available space. 
Fit to space makes a 
page size fit entirely.

A6.2 Zooming
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A6.3 Page Navigation 

Operates in Print View only.

Use these items to 
navigate the pages. These 
items can also be placed 
on toolbars. See section 
C2. Toolbars p101

Set the paper margins, 
(in mm if you are using 
A4 paper to print).

Choose your 
paper shape/size.

Choose the 
orientation.

Set the background 
colour.

To set defaults see the section C1. Start-up preferences.

A6.4 Page set-up, margins and paper colour

You can set the paper shape to match the paper type that you use and the orientation that 
best fits your screen layout. From the File menu choose Page setup…
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A7. Saving and opening documents

The distinction between documents and environments is described in section B3.1 Documents 
and Environments p63. In this section we are only concerned with the 
writing document area. The usual icons are available on the File menu and 
on toolbars for Open…, Save and Save As.
Documents are saved in the My Documents area for the currently logged-
on user.

A7.1 Auto-saving

You can choose to auto-save your document or environment periodically. If you are in 
write-mode then auto-save will save the document. If you are in design-mode then the 
environment will be saved.

Should anything go wrong with your computer or work, then when you next run the 
program you will be asked if you want to load the last saved version. 

If you say “no” at this time then this last saved version is deleted immediately.
If you say “yes” then the last saved version is loaded and then deleted. You should then go to 
Save As... and re-save your work with a name you choose.

The auto-saving is a back-up and should not deter you from saving your work regularly under 
its proper name.

You can set the times between such saves. The saving of complex environments or documents 
with large graphic files takes a few moments so it is advisable not to make this too frequent. 
The time can be set from the Tools menu, then select Preferences, then click on the System 
tab. 
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A8. Printing

If you have a continuous document and want to see the page breaks, then switch to Page 
break view, or Print View as described in section A6.1 Page presentation p34.

To print, go to the File menu and select Print… or select the print icon from the toolbar.

If your page has been set up to be portrait then the printer will automatically be set up to 
print that way, similarly if your paper is landscape. If you deliberately set the printer shape 
to be different from your document then the program will scale and centre the document to 
produce the best fit.
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A9. Speech

A9.1 Speech on demand

Select this to hear 
each letter spoken 
after it is typed.

Click this to hear each 
word spoken after it is 
typed. This is currently 
selected.

Click this to hear each 
sentence spoken after 
it is typed.

In the menu shown 
only one option is 
selected. But you can 
select any of the three 
options together.

Click here to hear the 
current sentence spoken. 
Click again to hear the 
next sentence, and so on.

If you mis-hear any speech, 
click here for it to be repeated.

A9.2 Auto speech

You can get speech feedback as you write. Use the Speech menu to choose what you require.
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A9.3 Voice selection

In Windows there are two types of voice to choose from called Sapi4 and Sapi5. You may not 
have a Sapi5 voice on your machine. If so then the menu will not allow it to be selected.

A Sapi5 voice is chosen using the Windows Control Panel. 

To set this Sapi5 type of speech to use in SymWriter from the Speech menu select Sapi4 or 
Sapi5, and then Use Sapi5.

If you choose Sapi4 you can also choose which Sapi4 voice to use, and the speed of that 
voice.

Select this to enable you 
to change the speed of 
the Sapi4 voice.

Select this to get a list of 
the Sapi4 voices on your 
machine, and choose the 
one you want.

Use the slider to change the speed.

A9.4 Setting Sapi4 voices
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A10. Spelling

A10.1 Marking errors

You can choose whether to show spelling errors or not. Simply go to the Text menu and click 
on Check spelling. When there is a tick by this menu item mistakes will be shown by a pink 
rectangle behind a misspelled word.

Select the correct 
word from the list.

Click here if you want the 
program not to mark this 
word as a mistake.

A10.2 Using the simple checker

To see suggestions for a spelling error, click with the right mouse button on the word. After a 
short pause you will see a list of suggested words illustrated by symbols where possible.
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A10.3 Using the full checker

A more interactive spell checker is provided for students using the program. Select Check 
spelling from the Text menu, or you can click on the spelling icon if it is shown in the 
toolbar set you are using.

The program will go through the document producing the following box. 

1. Click on a 
word to try.

2. Click to hear the 
selected word.

3. Click to see the 
selected word in the 
document. 

If the selection is 
not the one you 
want, click here to 
put the original 
word back.

4. Click to hear the 
sentence containing 
the selected word.

When OK click here 
to review the next 
mistake.

Click here if you want the 
program not to mark this 
word as a mistake.

Click here when you have 
finished with the spell 
checker.
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A10.4 Deleting extra ‘correct’ words

Sometimes a word may be accidentally marked as correct when it is not and so added to the 
list of correct words. You can delete items from the list of additional words that have been 
added. From the Text menu select Edit dictionary…

Select an item that 
has been added in 
error.

Click on Delete to 
remove the entry.

This shows a list of 
entries that have been 
added as ‘correct’.

If there are many 
entries, you can type in 
this box to help find the 
one you want.

Click here when you 
have finished removing 
entries.

Type the misspelled 
word.

Enter any suggestions 
for this word separated 
by a comma.

Click here when you are 
finished.

This will put your 
new suggestion in 
the list.

Click here to delete 
an entry.

Type in here to help 
find an entry. 

A10.5 Adding extra spelling suggestions

It is possible to offer suggestions for words that are commonly misspelled. For some 
predictable spellings, the spell checker cannot make a sensible suggestion. “Muvver” for 
“mother” is an example. To add suggestions for such spelling, from the Text menu select Edit 
spelling suggestions….
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A11. More advanced features

A11.1 Wordlists

In SymWriter, you can personalise the vocabulary by renaming an existing graphic, using F11, 
or by adding a different graphic to a word. These changes can be saved to a wordlist for 
future use.

A wordlist is a file that can link extra words to images that the symboliser does not produce 
on its own. These are usually for specialised personal vocabulary, but can also provide 
vocabulary for a specific topic. 

There are two types of wordlist:
(a) Topic wordlists

A topic wordlist normally relates to a specific topic or purpose and supplements the 
standard symbolisation, and so these lists are normally short.

Topic wordlists are stored in a shared area and are available to anyone who uses that 
computer. A topic wordlist includes any graphics in the list that are not part of the 
Widgit area and the list is saved with the document that uses it. This means that when 
passing documents from one machine to another you do not need to worry about any 
non-standard items that may be included. 

(b) User wordlist.
This is a set of wordlist changes that are personal to the currently logged-on user. This list 
is automatically loaded when the program opens. 
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You can select one 
or more wordlists 
from those listed.

Then click OK.

A11.2 Loading a Topic wordlist

To load a wordlist, select the Symbols menu then Wordlists and Choose wordlists... This 
will display all of the wordlists available in the Topic wordlist folder.

A 11.3 Setting a default Topic wordlist

You can choose to set one default Topic wordlist so that this list is automatically opened 
when the program is launched. This is done from the Symbol Source dialog, under 
Preferences. See C1. Start-up preferences.

You may open more than one list at a time. Open the choose wordlists box at any time to 
see which lists are currently loaded. 

If you wish to use other wordlists, for example from Communicate: In Print, those wordlists 
(with file extension .cwl) need to be copied into the Topic wordlist folder (Appendix 1 
Location of files p117). 

There is more information and utilities for managing 
wordlists at www.widgit.com/symwritersupport 
If you are connected to the internet you can click the 
weblink button on the launcher to go directly to that 
location.

These example lists 
are not included with 
the program.
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A11.4 Saving symbol changes

Any symbol changes or added graphics that are not part of the Widgit resources are saved 
with the document. There is no need to save symbol changes unless you wish to have these 
extra words available for creating other documents. You can, however save any word/symbol 
changes to a wordlist for future use if you wish.

From the Symbols menu, select Wordlists and Save Wordlist changes...

If you want to create a new wordlist for the entries, type 
the name in the box, then click Make new wordlist.

Click on the word 
you wish to add - 
the image is shown 
bottom right.

Then click Add to 
add the highlighted 
entries in the left 
column. Or click Add 
All to add the whole 
list.

Choose the wordlist 
to which you want to 
add the new entries.

You can create a new topic wordlist from the Save wordlist changes dialog. That list is 
automatically loaded with the current document alongside any other lists already open.

TIP: Creating a Topic Wordlist
The simplest way to create a specific topic wordlist is to create it in a new document and then 
save the changes to this list. For example, to make a Topic wordlist with photographs for all 
of the students in a group, type their names into the document and add the photographs to 
each name. Now go to Save Wordlist changes, create a new wordlist, and Add All to this 
list.
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A11.5. Transferring wordlists and graphics

Transferring wordlists and personal graphics from one machine to another

(a) Topic wordlists
Once you have used at least one word from a Topic wordlist that wordlist is linked to 
that document and will be saved with the document. 

Topic wordlists that have been saved with the document are automatically transferred 
to the new machine. If such a wordlist is already on the new machine, the two lists are 
merged. 

If the topic wordlist includes new graphics that are not part of the Widgit area, then 
these graphics are included as part of the wordlist. This means that you will not 
normally have to think about transferring any additional items along with a document 
(or environment). However, if your wordlist includes a lot of large images, such as 
photographs, then the document file can get quite large. It is advisable, therefore, to 
keep topic wordlists to small specifically focused content. 

(b) User wordlists
Any specific items from the user wordlist is saved in the document, so any personal 
photos used in that document are available on a new machine if the document is 
transferred. However, no other items from the user’s personal list are included.

The user list is designed specifically for the personal user. If you want to make any 
symbol/word changes available to other users, then these should be saved to a Topic 
wordlist and not to the User list.

Note: if you need to copy this User list to another machine, this list is stored in 
Documents and Settings\[User]\Application Data\Widgit\Common Files.

NOTE: Graphic file size for images used in wordlists

Photographs that are attached to words in a document are physically quite small on the 
paper and so the files really do not need to have very high resolution. In order to keep the 
file size to sensible proportions, it is a good idea to reduce the file size of the images before 
you link them into a document or wordlist. You can do this in your camera imaging software.

Wordlists that reference graphics that are part of the Widgit system are not included in 
the document, and so these wordlists remain quite small, even with fairly large numbers of 
entries.
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A11.6 Choosing how to symbolise

Usually you will want to use smart symbolisation plus any topic wordlists you choose. There 
may be times when you want to use a traditional type of wordlist that does not use the smart 
symbolisation, or to limit the number of words symbolised, or to use a completely different 
set of symbols. 

To choose the level of symbolisation select Symbolisation from the Symbols menu, and 
then select Use full symbolisation, Use non-smart wordlist or Use Topic wordlists 
only, 

You can use additional topic wordlists with either smart or non-smart symbolisation.
Topic wordlist will have priority over the other types of symbolisation.

A11.7 Creating an empty topic wordlist

You may want to create an empty topic wordlist ready to add items. To make a new wordlist, 
from the Symbols menu select Wordlists and then New topic wordlist. You will get a 
small dialog box where you can enter the name of your wordlist. Then click Create wordlist. 
A wordlist created in this way is not automatically loaded when it is created.

There is more detailed information on wordlist and how they may be edited on the website 
at www.widgit.com/symwriter
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B. Writing with grids

The purpose of grids is to assist students to write by giving pre-defined content. The writing 
window for the Document, together with grids and other tools to assist writing, is called the 
Environment. So creating grids is an important part of making the total environment for 
writing. The illustration below shows the main designer with a complex environment. The 
key terms are:

Stage
A stage is an area of the screen that can hold 
grids, trays, buttons and text boxes.

Button
A button is like a single cell that can be 
placed in a tray or directly onto a stage.

Section B1 gives examples of environments to provide you with an overview of the 
possibilities. 

Section B2 deals with many features of grid creation and editing. It deals with all the features 
that apply to a single grid. 

Section B3 and onwards describe how the arrangements of grids can be extended and how 
the environments containing the arrangements can be saved and used. 

Text-mode
This is used for writing 
text into grid cells.

Arrow-mode
This is used for most 
other purposes, for 
example resizing, 

linking, editing appearance and 
moving.
Switch between arrow and text-
mode by pressing the key F2.

Tray
A Tray is a free-form area 
where graphics and text 
boxes may be positioned 
freely. A tray may also have a 
graphic as a background.

Command Graphic
This is a graphic without a word attached, but 
which can be sent to the document either with 
some pre-defined text attached, or as a loose 
graphic for illustration.

Grid
A grid is a regular 
array of cells. Cells can 
be merged in a grid to 
make it semi-regular.

Cell
A cell is a single entity within a grid. 
Usually a cell has a border and is 
used to contain text and symbols.
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B1. Examples of what you can do

This section shows some finished examples to help provide an overview of types of 
environment and the grids they contain. Also on your CD are some step-by-step instructions 
for making some examples based around the theme of holidays. Later sections will describe 
how such activities are created.

B1.1 Example files

Simple writing grid with symbols

A single grid provides a basic vocabulary for 
writing about a simple topic. The contents of 
each of the main cells is sent to the document 
when it is clicked. 

In this grid there are two cells that have actions 
instead of vocabulary. The Delete cell deletes 
the previous word, and the Return cell sends a 
paragraph return. 

A sequential series of grids

This environment is for structured writing. It has 
a number of grids that are linked sequentially, 
using the “next” cell.

Linked grids with a menu 

This activity has a menu grid with three cells 
that link to secondary grids to give increased 
vocabulary. The secondary grids in this 
environment each have a cell that links back to 
the menu. 
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Text grids

This environment is to stimulate creative writing. 
It has a set of 3 grids with a separate menu. 
Two of the grids have words and the third has a 
number of pictures that can easily be added to 
illustrate writing.

Free form layout with pictures

This environment has pictures without words, but 
when these pictures are selected, they are added 
to the document with pre-defined text.

The next section describes how grids and environments are made.

There is also some information in the ‘Getting Started with Grids’ tutorials which give you a 
step-by-step guide to making some useful environments. These can be found on the web site 
– click on Visit the web button from the launcher.

This environment is for a tray holding a number 
of individual text boxes. If the picture in the 
centre is chosen it will be sent to the left of 
the writing. The small grid on the right gives 
punctuation.
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B2.1 Starting in Design-mode

To create Environments you need to start SymWriter using the Design environment button.

B2. Making a grid

This section describes the range of features that can be used to prepare a grid for use in 
making writing selections. In most cases only a fraction of this is needed in any particular 
case.

The Getting Started With Grids worksheets provide a step by step guide with the key 
features needed for making basic environments. You can find these under the Help menu in 
the folder Getting started.

From the Launcher 
click on the Design 
environment button.

From here you can also 
Load an environment, 
Create from a 
template and access 
Recent Environments. 

To create a new 
Environment select the 
stages you require and 
click Continue. (You can 
change the stages later if 
you wish).

This will open the Environment Designer dialog.
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B2.2 Choosing the layout of a grid

When working with grids and stages there are two modes to use:
(a) Text-mode. This is used for writing text into grid cells.
(b) Arrow-mode. This is used for most other purposes, for example resizing, linking, editing 

appearance and moving.

The mode is changed by clicking on the Text icon or the Arrow icon on the 
toolbar, or by pressing F2. 

To create grids you need it to be in arrow-mode.

Select the New Grid icon from the toolbar, 
or from the menu choose Environment, Grids, New Grid. 

Set the number of columns.

Set the number of rows.

Select whether you want 
symbols and text, or just text 
in the cells. (You can change 
this from cell to cell later).

Click here to re-load the 
system default colours etc. Click here to save the current 

settings as the system defaults.

Click Create and you will get a small image of the grid locked 
to the mouse. You can position a grid at the top, bottom, right 
or left of the screen. As you move the mouse in these places you 
will see stages appear in blue ready to receive the grid. Click 
when you are positioned where you want the grid. The rest of 
this section assumes a grid is placed at the bottom.

(You may already have made a stage ready to receive the grid).
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B2.4 Moving and resizing

In the example below we chose a 4 x 2 grid placed on the bottom stage.

If you highlight a number of complete columns and drag horizontally, then only the columns 
highlighted will be resized.

Similarly if you highlight a number of complete rows and drag vertically, then only the 
highlighted rows will be resized.

Drag these bars to 
position the grid.

Use these drag points to size the grid.

The grid viewer shows 
thumbnails of any grids.

You can adjust the height of the stage 
by dragging the thin grey bar at its top.

Drag to right

B2.3 Highlighting cells

Cells can be highlighted to enable the same action to operate on all highlighted cells.

Method 1. Drag across a group of cells.
Method 2. Hold down Ctrl and click in each cell you want to highlight. 



Communicate: SymWriter User’s Guide

54

B2.5 Moving cell boundaries

Position the mouse over a vertical 
boundary. 
The cursor will change to a drag 
shape indicating that the 
boundary can be dragged.

You can similarly change 
horizontal boundaries.

B2.6 Merging cells

Highlighted cells can be merged. Simply select the Merge icon from the toolbar, or from the 
menu, Environment, Grids, Merge cells.

B2.7 Breaking up cells

Cells which have been previously merged can also be broken up. Highlight the merged cell 
and select the split cells icon from the toolbar, or from the menu, Environment, Grids, 
Split cells up. You cannot split cells that have not previously been merged.

Merge icon.
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B2.8 Putting in content

To write text into a grid you need the program to be in text-mode. When moving and 
resizing, you need to be in arrow-mode. The icons for switching are on the toolbar, or you 
can press the F2 key.

Arrow-mode.Text-mode.

Keep typing

Once you are in text-mode you can click in any cell and start writing. The functionality in 
section A of this manual applies except that the contents of a cell will auto size to fit the grid. 
Note that in grids centre align is often useful.

Make a basic square of four cells, and in arrow-mode stretch them horizontally a little 
so that you can type into them. Switch to text-mode and in the top left cell, write the 
following:
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B2.9 Tidy cells function

When typing in a grid it is often the case that the text and graphic sizes often vary in 
different cells. The tidy cells enables you to get a smart looking layout.

Write the following into the appropriate cells,

To tidy specific cells, switch to 
arrow-mode (F2) and highlight 
the cells to tidy, then press the Tidy 
cells icon.

To tidy all the cells, click in any 
cell and press the Tidy cells icon.
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B2.10 Expand to fit

If, after tidying, you want the contents of a cell to fill the cell again, click in that cell and 
press the Expand to fit icon. This can also apply to a group of highlighted cells.

B2.11 Rows and columns

To expand more than one cell, switch 
to arrow-mode (F2) highlight the cells 
and press the Expand to fit icon.

Click in the cell and then press 
the Expand to fit icon.

You can insert a row in a grid either above 
or below the cell that is highlighted or 
which has the text cursor.

You can insert a column to the left or 
right of the cell which is highlighted 
or has the text cursor. You can also 
delete a column.

To insert or delete rows and coloumns, you need to be in arrow-mode.

Sometimes these icons may be greyed-out (i.e. not available). For example, if you have 
merged cells there are no clear horizontal or vertical positions to insert the row or column.

These functions are also available from the Environments menu, Grids, then Rows or 
Columns.

Delete a row.
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B2.12 Simple cell actions

In arrow-mode there are up to 3 small icons visible in a cell.

Click this action icon 
to see all the actions 
in a cell, and to add or 
delete actions.

This link anchor becomes coloured when the 
cell is “linked” to another grid or object.

In the case where there is just one grid the link anchor is grey. Adding grids and linking is 
dealt within section B4. Linked grids.

Click the action icon:

List of the principal actions.

Click here to see the 
full range of actions.

Click here to add a 
highlighted action.

In this case the only action is to send the 
cell contents to the writing document.

These icons can alter the 
order of the actions, or 
delete an action.

Move the mouse over an item in the left 
hand list and you will see a description of 
the command here.

Using actions is dealt within section B5. Using actions

This send icon 
appears when the 
cell is set to send 
some content to the 
writing document.
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B2.13 Testing a grid

If you have made the grid from the previous few sections, you may like to test it.

Click on the green Play icon on the toolbar (alternatively select Exit Design mode from the 
Tools menu).

2. Click the Edit icon to 
return to design-mode.

1. Select the cells to write to the document.

If you have not immediately saved your environment you will be asked if you want to Save 
the environment, Save a copy or Use without saving. We recommend that you save, or 
save a copy so that you can re-load the environment if necessary.

This program will then switch to write-mode, with the full Writing interface. When you 
have finished testing you can click on the red Edit button (or alternatively select Switch to 
designer from the Tools menu, and select Confirm).
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Make sure you are in 
arrow-mode. Right 
button click in a grid.

Now select 
Edit grid 
appearance.

B2.14 Grid appearance

This shows a picture, 
displaying the effects of 
your changes.

Click to apply the 
changes you have made.

Use these boxes to 
set the values of the 
properties listed.

Click on these boxes to set 
the colours for the border, 
background and line.

Click on these 
buttons to switch 
between colour 
and transparent.

This sets the 
automatic colour to 
indicate that a cell 
is linked to another 
grid. See section B4. 
Linked grids p66.
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You can select the appearance of individual cells, or groups of cells, by first highlighting the 
cell(s) you want to change:

In these ways you can change the appearance of all cells or selected cells at anytime. 

Right click.

Now select Edit grid appearance.

Highlight the cells you 
want to change.

Only these two cells 
will be changed.
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B2.15 Altering the appearance of a stage

Right button click on the background of the stage (outside the grid) to get the context menu.

Click on Stage Properties.

The dialog box that appears allows you to change the colour of a stage, or provide a colour 
gradient:

Click here to choose the colour.

Click in these icons to set the colour 
at either end of the gradient.

To set a colour gradient click here.

Choose whether the gradient 
is to be horizontal or vertical.
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B3. Environments

B3.1 Documents and Environments

The purpose of the grids is to assist writing into the document. The writing window, together 
with any other grids and objects to assist writing, is called the environment. 

In section B2. Making a grid you have seen how to make a simple grid for writing. That grid, 
and the empty document with it comprise the simplest environment. 

To use an environment, it needs to be opened in write-mode. The document that is created 
from the environment in write-mode is saved separately from its environment. Thus an 
environment may be used many times for different students to write, and a previously saved 
document may be re-opened after the environment has been loaded.

The toolbars that are seen with the environment will be determined by the user interface 
currently selected. (See section C2. Toolbars) 

Environments are created, edited and saved from design-mode (The environment designer). 
They may not be edited or saved in write-mode. (See section B3.4 Editing an environment 
from write-mode p65).

File menu in write-mode. File menu in design-mode.
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B3.2 Saving and Opening environments

When an environment is saved, all of the stages and their components are saved, together 
with the current writing document. The font and graphic details that are set for this 
document are saved with the environment. 

Save the environment using the Save environment icon or Save environment from the 
File menu.

If you have tested your environment (See section B2.13 Testing a grid p59) you may have 
some text and symbols in the document. You will need to delete this before saving the 
environment, unless you want it to appear every time that environment is opened  in write-
mode. You can use CTRL+A to select all and then press the Delete key. 

Environments are saved in a shared area so they are accessible to all users of that computer. 
They may be exported to, or imported from, other machines on a network or to storage 
media, such as a USB memory, using the Transfer from the File menu when in the 
Environment designer. 

Note: Teachers need write-access to the All-users ‘Shared Documents’ area in order to create 
and edit the various files and settings of the program.

B3.3 Templates

Within the area where Environments are saved, is a Templates folder. This contains some 
example grids. You can open these environments in either the designer or write-mode. 
However when you save the environment it will go to the Save As dialog. This prevents you 
from easily overwriting the template. You will have to deliberately go back to the Templates 
folder to over-copy the original. 

You can also save your own files as templates into the templates folder. This is useful if you 
have created some writing frameworks for other teachers to modify to meet individual needs. 

Save environment.
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B3.4 Editing an environment from write-mode

You may be working in write-mode when you realise that you need to make a change to an 
environment that you are using. You can change into design-mode using the red Edit button 
on the teachers toolbar or from the Tools menu select Switch to designer. You will need to 
confirm this (as a measure to prevent students inadvertently switching modes).

You can make your changes and Save or Save As with an alternative name. To return to 
write-mode, click on the green Play button, or select Exit design mode from the Tools 
menu. 
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B4.1 Auto linked grids

There is an easy way to create a stack of linked grids, that is a set of grids on top of one 
another, occupying the same space on the stage.

Make a 3x2 grid press the F2 key and 
type in this content. Press F2 to go 
back to arrow-mode. Hold down Ctrl 
and double click in the “food” cell.

This automatically makes a new grid of 
the same shape. It puts a “link” in the 
top left cell. In write-mode a single 
click here will recall the grid with the 
“food” cell. The green background 
indicates the link. (See section B2.14 
Grid appearance p60 if you want to 
change this colour).

Fill in the following contents for the 
other cells.

B4. Linked grids

There are two ways that grids may be linked: 

1. Auto-linked grids are made with a cell that returns to a grid from which the link was made. 
These links are often used in a stack where the top grid is a menu, linking to additional 
vocabulary.  

2. Manually linked grids can be linked sequentially or for links to be made between different 
stacks.
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This next step will anticipate section B5. Using actions and shows how to put in the correct 
command for the “return” cell. 

1. Highlight the Send cell 
contents action.

3. Highlight the Send a return 
action in the left list.

5. Click OK and the Send a return 
action is put into the cell.

You can now test this pair of linked grids as described in section B2.13 Testing a grid p59. You 
could then add grids linked to “sport” and “hobbies” in the same way.

Guidance for making a different grid Stack is given in Getting Started with grids 3 on the 
SymWriter webpage. From the launcher select Visit the web button.

In arrow-mode click in the 
‘cell action’ square of the 
“Return” cell.

4. Click the Add icon.

This will bring up the Cell Actions dialog.

Hold down Ctrl and double click in the 
“back” cell. This takes you back to the 
first grid. The “food” cell now has a 
green background to show it has a link.

2. Click the 
delete icon 
to remove 
this action.
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B4.2 Making a sequence of linked grids

This activity has a set of grids that are linked sequentially to make a continuous activity.  
Another activity of this type is described in the Getting started with grids 2 on the 
SymWriter webpage. These grids are manually linked.

Make a 2 x 5 grid (section B2.2 
Choosing the layout of a grid 
p52) and place it on the left of 
the screen so that it appears 
on the left hand stage.

Merge the top two cells 
(section B2.6 Merging cells 
p54) and press the F2 key 
for text-mode to fill in the 
grid as shown.

In arrow-mode click in the action icon of 
the “delete” cell. Click on the Send cell 
contents item in the right list box and then 
the X button to delete it. Now select Delete 
last word from the left hand list and then 
Add. This means that selecting the cell will 
cause the last word to be deleted.

Click in the action icon of the “next” cell. 
Click on the Send cell contents item in 
the right list box and then the X button to 
delete it. Now select Send a return from 
the left hand list and then Add. This means 
that when this button is clicked a “return” 
will be sent to the document. Later you will 
add the link to the next grid.
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Click in the action icon of the “These are alive” 
cell. Now select Send a return from the left 
hand list and then Add. This means that when 
this button is clicked a “These are alive” will be 
sent to the document followed by a “return”. So 
“These are alive” will act like a heading.

Now colour the backgrounds of the 
two cells shown. This is simply to draw 
attention to their different purposes. Use 
what colours you like (section B2.14 Grid 
appearance p60).

Make sure you are in 
arrow-mode (F2 if need 
be). Then holding down 
Ctrl, click in the top cell 
and the bottom two in 
order to highlight them.

Now right button click in the 
grid to produce the context 
menu. From the menu select 
Add new grid here. This will 
make a copy of the grid and 
also copy the contents and 
actions of any highlighted cells.
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All the grids are now made with the correct content and actions, except that we need to link 
them. In the next set of images the wide document space between the left and right of the 
screen has been cut away. Use the Grids panel to see the grids you have created.

1. Edit the contents of the cells to appear as on the left. 
2. Then make two more grids in a similar  way. When making the last grid, do not highlight 
the “next” cell, as there are no more grids in the series.

1. On the right is the grid viewer. 
This gives small thumbnails of 
the grids available. Click on the 
top grid to bring it to the front.

2. You can name a grid, for 
your own reference, by double 
clicking in this box, typing the 
name and then press the Enter 
key. See section B4.4 Storing 
information about a grid p76.

3. Now click in the link anchor in the 
“next” cell, and drag to the second grid in the 
viewer. This means that a click in the “next” cell 
will cause the second grid to be displayed.

Drag

1. 2.
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Now click on the second 
grid to bring it to the front.

Similarly, drag from the link anchor 
in the “next” cell, and drag to the third 
grid in the viewer. This means that a 
click in the “next” cell will cause the 
third grid to be displayed.

In the same way you should now link the “next” cell in the third grid to the last grid in the 
set.

Click in the grid viewer to bring the first grid to the front. Now go to the File menu and 
Save environment to save your work. You can now also click on the Play button to try out 
your environment (section B2.13 Testing a grid p59). You should clear any test work before 
returning to design-mode. If you do not and you need to re-save your environment, then the 
text in the document is also saved. (There are circumstances where you may want to create 
environments with text already in the document).
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B4.3 Using two separate grids

In this activity you will see how to make an environment with a ‘menu’ grid where each cell 
simply acts to link to a grid in a separate set. This allows each grid in the set to come to the 
front when the appropriate ‘menu’ cell is selected. The menu is a 2x2 grid. Make this first, put 
it on the bottom stage, then move it to the left as below (sections B2.2 Choosing the layout 
of a grid p52, B2.4 Moving and resizing p53).

The grid stack is to be 4x2 but the contents – described soon -  need to have different sized 
cells.

Put the 4x2 grid on the bottom 
stage and move it to the right.

Highlight the left 2 cells of the 4x2 grid and drag the grid wider. 
Then drag the central four cells to be a bit wider, until the 
proportions are roughly are shown, (section B2.4 Moving and 
resizing p53).

Now enter the content as shown. The 
four central cells of the right hand grid 
have been ‘tidied’ (section B2.9 Tidy cells 
function p56).

The Menu grid
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The list shows any actions that are 
common to the highlighted cells.

Click on Send cell contents, 
then on the X to delete from 
all the highlighted cells.

In the 4x2 grid use Ctrl and click to highlight the 
central four cells. Right button click and then select 
Edit actions for selected cells…. Use the dialog box 
that appears to add Send a return to these cells. This 
enables each statement to be seen on a separate line 
when the student writes.

Use the action button on the “delete” cell to produce the Edit cell actions dialog, and then 
remove the Send cell contents, and add the Delete last word action – as described on B4.2 
Making a sequence of linked grids p68. The first grid is now complete.

We do not want selections in the menu grid to send anything to the document so we need to 
remove the Send cell contents action from each cell.

Use the mouse to highlight the four 
cells comprising the menu grid on 
the left side. Then right button click 
to produce the context menu. Select 
Edit actions for selected cells….
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To make a new grid: Highlight the “delete” cell as 
we want this to appear on each grid. Then right 
button click on the grid and from the context menu 
select Add new grid here.

In a similar way fill this grid 
in, and then make two further 
grids as shown. 

Don’t forget to tidy the central 
cells and add Send a return 
to them.
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1. Click on the Show 
toolbox button at the base 
of the grid viewer. Then on 
the cells tab. You will see 
here icons that have already 
been described, above, on 
the toolbar. You may find 
them more easily accessible 
than on the toolbar. 

3. Click on the Link Tool 
button. Then click in the 
“people” cell. As you 
move the mouse a line will 
connect to the cell. Move 
the mouse to the second 
grid in the stack in the 
grid viewer and then click 
again. This creates the link.

Bring the third grid in the stack to the front by selecting 
it in the grid viewer. Then, as above, select the Link 
Tool button. Click in the “TV” cell then move the mouse 
to the grid on the right. The line follows the mouse as 
shown. Just click anywhere in the grid to make the link. 

Complete the links from the “activities” cell in whichever way you prefer. 

The environment is now complete. Save it and test it as described at the end of section B4.2 
Making a sequence of linked grids .

2. Click on the 
Cells tab.

Further Method 1

Further Method 2

The grids are now made. All that remains is to link them up. Link the “places” cell from the 
menu grid by dragging from the Link anchor to the first grid in the grid viewer. This was 
described in the last section. There are two further ways to link that achieve the same effect, 
and you can choose which one suits you.
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B4.4 Storing information about a grid

You have seen in section B4.2 Making a sequence of linked grids that a grid can be named for 
reference using the grid viewer. It is also possible to name a grid and store extra information 
for your own reference. Right button click on a grid and from the context menu select Edit 
grid appearance. Select the Grid info tab.

You can type the grid name here.

You can make notes here 
about your grid. These notes 
will appear when you hold the 
mouse stationary over the image 
of the grid in the Grid viewer.

These notes may be helpful to remind you of specific techniques when you re-visit the 
environment, or to give advice to colleagues who may edit a copy of this environment later.  

Using auditory prompts for mouse users

When in write-mode you can use auditory prompts as described in section B7.3 Auditory Scan 
p92 with a mouse. Simply right button click to get the speech or sound feedback.

B4.5 Miscellaneous
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B5.1 Basic actions

To produce the Edit cell actions dialog click in the action icon in a grid cell.

B5. Using actions

You have already seen the Edit cell actions dialog in use. This section gives an overview of the 
actions available.

List of most commonly used actions.

Obtain a full list 
of all the actions.

Adds the selected 
action to the cell, 
or selected cells.

These icons enable the order 
in which the actions are 
performed to be changed.

Removes the action selected 
in the right hand list from the 
cell, or selected cells.

Describes the 
action where the 
mouse is hovering.

This shows the most commonly used actions. To see in detail what an action does before 
adding it, you can hold the mouse over it. A detailed description will appear in the panel at 
the bottom.



Communicate: SymWriter User’s Guide

78

B5.2 Range of actions

In addition to the short list of the most common actions, you can access a very large number 
of other actions that can be created in a cell.

Click on the See more actions… button.

You can now see the full range of actions 
arranged into categories.

Click on the + next to each category to see 
the actions in that category.

Select Send cell 
contents. You will 
see this area appear.

Click Edit and you can 
change whether the 
action speaks after 
sending or not.

Some actions are complete in themselves, for example Delete last word, whilst others 
require the input of additional information.

Type 1. Actions that can have extra information, but are provided with a default.

The Send cell contents action, for example, can have extra information to indicate whether 
the text just sent should be spoken after the contents have been sent. This defaults to No. If 
an action has extra data then it can always be edited at any time, as indicated in the image 
above.

Another example is Send a graphic from the basic action list. Here the graphic defaults to 
being in the centre, but you can edit that to be align left or align right.
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Another example is Speak pre-defined text (from the Speak and Sound category).

(b) Actions that need colour:
An example is change text colour from the Text formatting category. Here you need to 
supply the colour:

(c) Actions that need a size:
Examples are change the text font from the Text formatting category, change symbol 
size from the Symbol sizing category and change graphic size also from the Symbol 
sizing category. (This last action sets the size of the graphic that is next inserted into a 
paragraph – See section B5.3 Example showing how to send a picture p80).

(d) Actions that need a path:
Examples here are Load document from the Saving and Loading category, or program 
from the Link category.

Set the size in the box by 
typing in the size or using 
the up and down arrows.

Click here to browse for the file.

Enter the text to send here.

Type 2. Actions that must have extra information provided.

When you select such an action you will be prompted for the extra information as soon as 
you click Add. You can edit it at any later time. Examples are:

(a) Actions that need text:
Here an example is Send pre-defined text (from the Send category). You need to supply 
the text to send, so the following dialog box will appear.
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B5.3 Example showing how to send a picture

This example will show you how to put a graphic in a cell, and send that to the document as 
an illustrative picture positioned to the left of a paragraph.

2. Click on the action 
icon in the cell.

1. Using the graphic browser drop a picture on a cell.

4. Select the Send 
cell contents action 
and use the X icon 
to delete it.

7. If you wish to change 
the position later, click 
on Send a graphic in 
the right hand list, and 
then on Edit. Change 
the alignment to be left. 
Click Update.

6. Select Send a 
graphic and click Add. 
This brings up a dialog 
to set the position of the 
graphic, and then click 
Add.

3. Select the See more 
actions… button. Then 
choose the Symbol 
sizing category and set 
graphic size. 

Type 75 in the edit box 
and click Add Action.

5. Then select Return to 
shortlist.
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8. The actions are now set. 
Go to Test and click on the 
‘duck’ cell to see the picture 
inserted at the left.

You can modify this process easily to place the image in the centre. You could also add a 
command to Send a return, so that the image would then be positioned centrally with the 
cursor in the next paragraph underneath, ready for typing or further information to be sent 
from the grid.

B5.4 Changing actions in multiple cells

You can add or remove actions to a set of grid cells. 

Highlight the cells you want to apply the same action to, by dragging across them, then right 
button click to produce a context menu. 

From the menu select Edit actions for selected cells… Adding and removing actions in this 
way has already been illustrated in section B4.3 Using two separate grids p72. 

When a series of cells are selected, the actions that appear in the right hand list, are those 
actions that are common to all the selected cells.

B5.5 Sound feedback in cells

By default a right click on a cell in write-mode, will enable the user to hear the text in that 
cell. You can change this to speak alternative text or to play a sound file as described in 
section B7.3 Auditory Scan p92.
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B6.1 What is a tray – overview

In SymWriter it is not necessary to use grids. Grids are really quick and useful for arranging 
cells in a regular (or semi-regular) form. Sometimes it is better, or more attractive, to have an 
alternative way of arranging objects where they can be positioned and sized independently. 
In SymWriter a tray is a holder for such a group of objects. A tray can have a graphic as a 
background. 

On a tray you can place:
		  • Graphics
		  • Buttons
		  • Text boxes

Each of these objects has access to the Edit cell actions dialog and so they can behave much 
the same way as cells in a grid.

Also you can link to a tray in the same way as you can link to a grid. Trays can be stacked like 
grids. In fact you can mix trays and grids in a stack.

B6. Trays and buttons

B6.2 Making a single tray

The icons relating to this section are in the default toolbar for designing environments.

From the launcher select the Design environment button. Then create the environment 
with a single stage at the bottom of the screen (See start of section B2. Making a grid).

New tray.

New button. New text box.

Edit appearance of 
any of these.
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Select the New tray icon.

This works just like making a 
grid, except there is just the 
single whole tray.

When you have set the colours 
etc as you wish, click Create, 
then drop the tray centrally onto 
the lower stage.

Now click on the Graphic tab to 
show the graphic browser. Click on 
a graphic, we chose a bucket, and 
then click in the tray.

Size the graphic as you like (we call 
this a Command Graphic).

Then click on the Action icon to add 
actions to the graphic. 

We chose:
	 • Send a graphic
	 • Send pre-defined text 
	   (“The bucket is under 
	   the sink”).
	 • Send a return
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Adding a new text box

Now select the New text box icon.

This works just like making a grid, except there 
is just a single box, and the defaults are likely to 
be near those that you may want for a text box. 
Also text boxes have the command to Send cell 
contents set by default. Otherwise a text box and 
a button are identical in what they can do.

Now select the New button icon.

This works just like making a grid except there is 
just the single whole button, and the defaults 
are likely to be near those that you may want for a 
button.

When you have set the colours 
etc. As you wish, click Create 
button, then drop the button 
onto the tray.

When you have set the colours etc 
as you wish, click Create text box, 
then drop the text box onto the 
tray. Drag the text box to the size 
you want.

Adding a button

You can drag the button to what shape and size you like. Buttons 
behave like a cell so you can use F2 to go to text-mode, and type 
into the button. Here we then clicked on the action icon in the 
button and set the single action Delete word.

(There is an example of this kind of activity in the Example Environments folder called what 
can I find.swe).
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You can now save the environment and go to try your work. This is what was obtained after 
selecting the bucket and then the text box.

You can see that this tray could be one of a set in an activity about finding where things are. 
Trays can be stacked and linked in a very similar way to grids.

Press F10 to put the text box into symbol 
mode. Type a sentence into the text box. 
Press F2 to go to arrow-mode and click 
on the action icon in the text box and 
add the action to Send a return after 
the Send cell contents.
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B6.3 Altering the appearance of a tray

The appearance of a tray can be edited in the same way as a grid. Right button click in the 
tray and select Edit tray appearance. You can also use the edit appearance icon from the 
toolbar to modify the properties of a tray, a button or a text box.

The dialog box that appears is the same as that used to create the tray, see section B6.2 
Making a single tray p82.

Adding a background graphic

You can also use a graphic as the background for a tray. From the graphic browser drop a 
graphic onto a tray. Right button click on the graphic:

You select the object then 
click on the edit appearance 
icon from the toolbar.

Select Make this graphic the background.

Select Clear background image.

You can delete a tray by selecting 
Delete this tray. Or you can press the 
Delete key when the tray is selected.

Removing a background image
Right click on the graphic.
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B6.4 Linking trays

You can create a stack of trays, or trays and grids, in the same way that you created a stack of 
grids in section B4.2 Making a sequence of linked grids p68. Right button click on the tray to 
bring up the context menu.

When a stack has been created each tray and grid will appear in the grid viewer. Linking from 
graphics, buttons and text boxes on a tray works exactly like linking from cells in a grid. The 
link anchor will show in each of these objects, and links can be made as described in sections 
B4.2 Making a sequence of linked grids p68 and section B4.3 Using two separate grids p72. 
There is nothing new to learn.

You can select Add a new grid here 
or Add a new tray here, according to 
whether you want to add a grid or a tray 
to the stack.

B6.5 Using buttons direct on a stage

You can drop buttons and text boxes directly onto a stage. They behave the same way as 
when dropped onto a tray but will remain permanently visible. This is useful so that certain 
common commands, such as delete word, can always be available to a mouse user. It is 
less useful for switch access – see section B7. Switch scanning – as it is better to keep these 
functions within the scanning grid.
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B6.6 Using multiple stages

You may want to use more than one stage, for example a menu grid down the left and a 
stack of other grids at the bottom. This shows the sort of layout:

To achieve this two stages are needed. These may be produced by selecting them at the 
outset using the dialog that appears from the launcher, i.e.

Each selection of one of these 
menu cells will access one of 
the grids in the bottom stack.

Select these two stages 
and then Continue.
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Stages can, however, be added or removed at any time using items on the toolbar:

To make a new stage, select the New stage icon and move the mouse to the side of the 
screen where you want the stage – a “ghost” image of the stage will appear. Click when the 
ghost image is correct.

To delete a stage, click on the Delete stage icon and then on the stage you wish to delete.

You may find that the default “front to back” order of the stages is not what you need, for 
example you may want the left stage to be at the front.

Don’t forget that you can change the size of a stage by dragging the grey bar at its 
edge.

New stage. Delete stage.

Right button click on the left stage and 
select Bring this stage forward.
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B7.1 Setting up switch scanning

From the Tools menu select Accessibility then Switch options….

B7. Switch scanning
You can use switch scanning in SymWriter by connecting the computer to an appropriate USB 
Switch interface. These USB devices will generate a particular key stroke when the switch is 
pressed. SymWriter can choose the keystroke(s) according to the interface box you are using. 
These keystrokes are also useful for teachers to test activities for their switch accessibility 
without the need for switches to be connected. You need to select keystrokes that are not 
used in writing a document.

Choose whether to use 
one or two switches.

If you select 
one switch 
then set the 
scan rate here.

The switch interface 
box will generate a key 
stroke when a switch 
is pressed. Choose the 
key stroke according to 
the interface you use. 

Click here to choose the 
colour of the scan indicator.

Set the type of 
scan. See section 
B7.2 Types of 
switching.

Click in this 
box to switch 
auditory scan 
on or off.

When auditory scan is actually 
speaking, the scan indicator 
changes colour to show it is 
momentarily disabled. Click here 
to set the colour of this scan.

Click here to save 
these settings as 
system defaults. See 
section C1. Start-up 
preferences for saving 
individual settings.

You can save settings for individual users so that an individual can load their own interface, 
including their personal switch setting. See section C2.4 Adding an interface button to the 
launcher p105.
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B7.2 Types of switching

1. Horizontal scan. 
The scan indicator moves horizontally, and after the last cell in the row it moves to the left of 
the next row.

2. Vertical scan. 
The scan indicator moves vertically, and after the last cell in the column it moves to the top of 
the next column.

3. Column/row scan. 
The scan indicator indicates a whole column and moves to the next whole column with a 
single “beep”. When a selection is made, the scan moves down the individual cells in the 
column, after the bottom cell the scan indicator disappears and a double “beep” is heard. 
A selection at this time enables continuation of the scanning of whole columns in case a 
mistake in selecting that column has been made. Otherwise the scan continues at the top of 
the same column.

4. Row/column scan. 
The scan indicator indicates a whole row and moves to the next whole row with a single 
“beep”. When a selection is made, the scan moves along the individual cells in the row. After 
the right hand cell the scan indicator disappears and a double “beep” is heard. A selection at 
this time enables continuation of the scanning of whole rows, in case a mistake in selecting 
that row has been made. Otherwise the scan continues at the left of the same row.

These scans apply to regular grids. You can also scan irregular grids and other items in trays 
or on a stage. In these cases you must set the order of scanning by hand, as the computer has 
no information as to what is sensible. See section B7.4 Setting what happens after selection 
(regular grids) p93.
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B7.3 Auditory Scan

By default, auditory scan will speak the text visible in the cell. There may be times when 
there is no cell text, or for some other reason you want different behaviour. You can set 
the text to be spoken by auditory scan, or you can set a sound file to provide the auditory 
feedback.

Make sure you are in the design-mode and use the F2 key if necessary to set arrow-mode. 
Click in the cell to highlight it, and then right button click to produce the context menu.

Select Edit auditory scan sound 
for selected cell….

The following dialog is then available:

Cell text is 
the default.

To use other text for the cell, click in Custom text 
and then type the text you wish to be spoken.

To play a file click 
in Sound file and 
then on the browse 
button to select the 
file you want.

Changes to the Auditory scan options will also apply to a right button click in a cell in write-
mode.
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B7.4 Setting what happens after selection (regular grids)

After a cell is selected in a regular grid, the default action is for the scan indicator to move to 
the next cell. Sometimes this is not the most convenient thing to happen from the point of 
view of the switch user, so other possibilities are available:
		  • Stay on this cell
		  • Move to end cell
		  • Move to start cell

To alter the default setting make sure you are in arrow-mode and first highlight the cell (or 
group of cells) that you wish to change. With the right button click anywhere in the grid to 
produce the context menu.

The following dialog will appear.

Select Edit scan behaviour 
for cell...

The settings will apply to the cell or 
cells highlighted – or to the whole 
grid if you check Apply to all cells.
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B7.5 Setting the scan order

The scan order of items in a tray must be defined when the environment is created. Although 
a default scan order is set by the program this may not be suitable. To set the scan order 
either Right click on the tray in arrow-mode and select cell order. You can also add the 
scan order icon to your toolbar if you wish to do this frequently. See section C2. Toolbars.

You will see numbers attached to each object in the tray. This is the default scan order - in the 
order the objects were put on the tray.

Scan order.

Click on the objects in the scan 
order you want. If you get it 
wrong, just start clicking again.

Click out of the tray when you have finished.
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C. Preferences and toolbars

Default user buttons: the 
red button has the least 
items and yellow the most.

Individually configured 
interface buttons.

Overview

This section deals with the start-up preferences and toolbars, which together comprise the 
working interface.

The four non-expert buttons give a range of toolbars. The default start-up preferences will 
apply to all four of these toolbar sets and also to both the expert interfaces: Write Document 
and Design Environment.  

An interface is normally opened through buttons on the launcher.

Each button sets up two different aspects of the program:

		  • The toolbar interface.
		  • The start-up options such as font and graphic sizes, whether symbols show, 
      and many others including switch settings.
 

In addition to the default buttons, you can set up 10 of your own interface buttons to add to 
the launcher. These buttons are created by configuring the toolbars you want and you can 
save the current document settings and switch access, to this button. Section C2.1 Changing 
the toolbar buttons and layout describes how to make your own toolbar interface. Section 
C2.2 Changing your default expert interfaces explains how to create a button to launch the 
program using a new interface with saved toolbars and preferences.
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C1.1 Start appearance

The preferences set the start-up conditions of the program. 

This section shows you how to set up the start-up preferences that apply to the default 
buttons on the launcher.

From the Tools menu select Preferences… There are several tabs on this dialog box. Not all 
of the tabs are immediately visible, and you will need to use the scroll buttons to navigate 
across the complete set.

Sets the background colour 
of the writing document.

Sets how the pages 
are displayed.

The printer will scale the 
document to fit, so it is the 
shape of the paper that 
is important. (All A sizes 
have the same shape.) Also 
you can set the default to 
portrait or landscape.

Sets the paper margins.

Sets the zoom level so that the 
document either fits the available 
width or the available height.

Use the left and right scroll 
buttons to scroll through 
all of the preferences tabs. 

C1. Start-up preferences



Communicate: SymWriter User’s Guide

97

Symbol line colour
See section A3.12 Line colour 
of symbols p27.

Colour in symbols
Choose whether you want colour 
or monochrome symbols. This can 
be set separately in the writing 
document from symbols in grids on 
stages. 
See section A2.8 Changing 
properties of the whole document.

Sets the font and graphic 
properties in the writing 
document. 
See section A3. Text and symbol 
formatting.

Sets the font and graphic 
properties in grids. The sizes 
are automatic when typing in 
a grid cell.

This sets the default size 
of a graphic dropped into 
a paragraph.

Skin tone
Click in the radio button 
underneath the colour to set 
the default skin tone. 
See section A2.6 Skin tones.

C1.2 Colour Settings

C1.3 Text/Graphics
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Sets whether symbols appear by 
default or not. See section A4.1 
Writing in text.

Sets which qualifiers are shown 
by default: plurals, comparatives 
and superlatives, and tense. 
See section A2.9 Qualifiers.

Sets whether the symbols 
appear above or below the text.

Some settings can be made separately for symbols on stages.

This sets the frequency of 
Auto-save. 

Distance of the scroll of the 
mouse wheel. Number of levels of undo 

that are stored.

You can set the number of levels of undo. This is set as a default of 10, but you can set it 
higher or lower. Undo uses memory to store the data needed to undo each step, so you 
should not make the undo level high unless your computer has plenty of memory. 

C1.4 Symbolisation

C1.5 System
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Location of Widgit Pictures, 
you are unlikely to need to 
change this.

Sets the default type of voice 
to be used. See sectionA9.3 
Voice selection

Sets whether spelling errors 
are marked by default. 
See section A10. Spelling.

Sets whether speech is heard 
by default when typing. 
See section A9.2 Auto speech.

Location of shared resources.

This is where you store your 
personal pictures. 
See section A5.1 Adding pictures 
– the graphics browser .

C1.6 Graphic Locations

C1.7 Speech and Spelling
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Specify the symbol set. (If you 
have also purchased the PCS 
add-on set. 
See section A2.10 Symbol sets.)

Choose full smart symbolisation, 
non-smart wordlist or only use 
your own wordlist. You will only 
want to choose this last option 
if you have made a specially 
constructed list. 
See section A11.2 Loading a 
Topic wordlist. 

You can choose to have a particular Topic wordlist open 
by default every time you open the program. You can also 
open a topic wordlist at any time while writing. 
See section A11.2 Loading a Topic wordlist. 

C1.8 Symbol Source

The non-smart wordlist works in the same way as the wordlists in Writing With Symbols 2000 
and Communicate: In Print 2, where you need to manually select the option for all words 
with alternative symbols.

There is more detailed information on wordlist and how they may be edited on the website 
at www.widgit.com/symwriter
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C2.1 Changing the toolbar buttons and layout

Open SymWriter from the green button on the launcher. From the View menu select 
Configure interface….

This is the view that you see if you select a non-expert interface. With this you 
can change the toolbars for this session only. To save an interface for future use 
you need to be in one of the “expert” modes, either Write document or Design 
environment.

C2. Toolbars

Toolbars panel lists 
the different toolbars 
that are used in this 
interface. Click on 
each of the toolbars 
in this list to see it 
highlighted on your 
own toolbars.

Current toolbar buttons panel shows 
the buttons that are on the currently 
highlighted toolbar. 

Move this slider to change the 
size of the buttons on the toolbar.

Available buttons lists all the 
remaining possible icons available to 
add to the current toolbar.

Click on text and symbol in the Toolbars list on the left. In the Current Toolbar Buttons 
panel on the right you will then see a list of the buttons and their names which this toolbar 
contains.

You can make an immediate temporary change to any of the toolbars whatever level of 
access you have. You can also load any pre-saved toolbar sets. However you cannot save 
toolbars unless you are in one of the two expert modes accessed through Write document or 
Design environment.
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Adding, removing and ordering of buttons

The central buttons allow you to add or remove buttons and move them up 
or down in the list. Try adding something now and moving it. You will see the 
changes immediately in the toolbars on your screen.

Moving individual toolbars

You can also move the toolbars to change their order or to create a second row.  

When you click OK, the changes you have made will be available for immediate use. They will 
not, however remain once you have returned to the launcher, or closed the program. If you 
do not wish to use your changes, but to revert to the originally selected interface, close the 
dialog box with its Close icon. 

You can also load another saved toolbar set from the Open interface button.

Pick up the toolbar anchor 
(two vertical lines) to move it 
to a new position.



Communicate: SymWriter User’s Guide

103

C2.2 Changing your default expert interfaces

To edit or create toolbars to save, you must be in one of the expert modes.
From the launcher, select Write document, and then go to the View menu and select 
Configure interface.

This will show you the current toolbars. There are different default toolbars when you launch 
from the Design environment button. However the process of editing those is exactly the 
same as described below. 

You can edit the current (expert) toolbar in the way described in C2.1 Changing the toolbar 
buttons and layout and by clicking OK will be able to use those changes without changing 
your default.  

If you have been experimenting and don’t want to use these changes, you can click on 
Re-load my default, to restore the original.

To use the setting in the future for the Write document button click on Save current as 
my default.

If at any time you want to return to the expert interfaces provided with the program 
then choose the Tools menu, Restore expert interfaces->Writing or, Restore expert 
interfaces->Design, as required. 
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C2.3 Creating and editing interfaces

Go to the View menu and select Configure interface and you can create completely new 
toolbar sets provided you are in one of the Expert modes. 

The three toolbar control buttons are:

To start from the beginning, delete all the existing toolbars in the left column. Alternatively 
open an existing saved interface to modify. There are copies of the four default student 
interfaces available for you to use as a starting point. These are named after the colours of 
the buttons. 

Edit  the toolbars as you want, including deleting or adding new ones, and setting the 
toolbar size. 

When saving an interface, as well as the toolbars, it will save the status of the graphic and 
symbol chooser panels. You can open or close these now before saving your new/modified 
interface.  

When you have finished, click Save and give the new interface a name, or select an existing 
one to over-write it.

Note: You cannot edit the four default user interfaces.

Create a new toolbar

Delete a toolbar

Rename the highlighted toolbar.
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C2.4 Adding an interface button to the launcher

When you have saved your new toolbars for an interface you can click on the Launcher tab 
of the Edit Toolbars dialog to create a button on the launcher for this interface. You can 
have up to 10 additional buttons.

When you save an interface to a button, you can also include some of the document settings. 
These include: 

• Font name, size and colour.
• Symbol size, symbols on/off, text on top of symbol.
• Qualifier settings.
• Leading and tab settings – see sections A3.5 Paragraph alignment, word and 

line spacing and A3.6 Tabs.
• Speech and Spelling settings.

It is best to write a few words into the document behind the configurator panel and to 
change any settings as necessary from the menus. 

1. Click on the drop-down arrow to 
select a saved interface for the button.

2. Enter some short text 
to label the button.

3. Navigate to find an 
(optional) image for 
your button.

7. Move or delete selected 
user-defined buttons.

4. Check this box to save 
the current document 
settings with the interface.

6. Add this button to 
the Launcher panel.5. Check this box 

to save the current 
switch settings.

You can delete user defined buttons and change their order. Highlight any buttons you wish 
to delete and select Remove button(s). To change the order of buttons highlight two or 
more and select Change order.

You can edit a button by highlighting it, make the changes you want, and then click Add.

8. Add to desktop 
link. See section 
C2.5 Creating a 
personal desktop 
link for an 
interface.
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C2.5 Creating a personal desktop link for an interface

You can create a desktop icon to automatically open the program with a specific user-defined 
interface. This link can also automatically open with a pre-selected environment.  

Click on the Launcher tab of the Edit toolbars dialog. Select the interface file from the list, 
(task 1, C2.4 Adding an interface button to the launcher) check the relevant settings boxes 
(task 4, 5, C2.4 Adding an interface button to the launcher) and then click on Desktop Link. 
You will then have the option to select from one of the environment files from a pop-up list.

You will then find a new icon on your desktop.
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D Symbols

D1. Issues of symbolisation

1. Selecting the most appropriate image

Many words can have different meanings or different nuances. It is important that you select 
the correct symbol to represent your meaning. The smart symbolisation in SymWriter will 
help by recognising the part of speech. For example the word ‘suspect’ can be a verb such as 
to distrust, a noun meaning somebody under suspicion, or an adjective to be doubtful.

Fortunately the ‘smart’ symbolisation understands the grammar of the sentence and will 
choose, where possible, to give the most appropriate symbol. 

In the following sentence case each meaning has a different part of speech, and so the smart 
symboliser can offer sensible choices. 

However, in the case of ‘match’ the verb is easy to identify, but there is no way to discriminate 
between the two nouns, and so you would need to make a selection:  

2. Levels of symbolisation

There are different views about the appropriate level of symbol support for text. There are 
however two distinct types of symbol usage: 

(a)	 where the reader relies on the symbols to provide the information.
(b)	 where the reader is primarily accessing the information through the text but is 

supported by symbols to represent either the key concepts or specific vocabulary.

The reader may rely on the symbols, perhaps because they have cognitive difficulties that 
makes de-coding text difficult, or because they have significant difficulties with the language.   
In these cases it is not essential to support every one of the text or spoken words, but it is 
essential that all the key concepts are represented. 
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Where the reader is largely reading the text, the symbols take a supportive but incidental 
role, and may only provide support for specific vocabulary. For example a student who is 
learning about electricity, may read the words, be able to build a circuit, but may still be 
confused between the terms voltage and current. In these cases the symbol can remind the 
reader of the concept behind the word.

D2. Five golden rules

Whichever level of support you use, the following five golden rules should be helpful:

1. Layout = Punctuation

A symbol reader may not see normal punctuation so you have to achieve this through layout. 
Never string two sentences together on the same line. Ideally keep a sentence to one line, 
but if you have to wrap, put the line break at a natural speaking pause or an ‘and’. 

Example 1a. Incorrect layout for a symbol reader. 

Example 1b. Correct layout.
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2. Choose symbols carefully

Many words have more than one meaning, so there are often alternative symbols. SymWriter 
allows you to view these alternatives, so choose your symbols carefully. Sometimes the 
differences in concepts are quite subtle. 

Example 2a. Significantly different meanings of words.

Example 2b. More subtle symbol alternatives.

3. Remove abstract symbols

Not all symbols are necessary, especially for people who are new to symbols. Abstract 
concepts like ‘a’, ‘the’, ‘if’ ‘but’ and ‘so’ can be removed. For readers unfamiliar with symbols, 
only the main concepts should be symbolised. More abstract symbols will need to be taught. 

4. Read back the symbols 

It is important that all the main information-carrying words are symbolised. When 
symbolising, read back the words you have symbolised. Try covering up the words - do you 
understand the meaning? 

5. Don’t mix symbol sets 

There are many symbol sets around. The most common sets are the Widgit Literacy Symbols 
(previously known as Rebus) and the PCS (Picture Communication Symbols). If you know 
the sets and their structure then it is fine to mix symbol sets. If you don’t, it is best to avoid 
mixing as they may represent concepts in different ways.
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D3. The Widgit Literacy Symbols

The Widgit Literacy Symbols (WLS)  have been developed especially to support literacy. 
Previously known as the Widgit Rebus Symbols, they have a clear schematic structure to 
much of the vocabulary, have been designed to have the minimum detail to reduce the visual 
clutter of the page, and have some optional grammatical markers to support developing 
writers. 

Whilst many symbols are immediately recognisable by anyone, others need to be learned. By 
using a common and consistent design criteria, the WLS aim to make the learning task easier.

Description of the Widgit Symbol schema and conventions

The following are the principal schema and conventions.
Buildings: 
There are two styles of building: standard and large buildings. This enables distinction 
between buildings such as corner shop and supermarket, clinic and hospital. 

Rooms: 
A room is a square. This enables distinction between a library as a separate building and the 
library in a room on a school, or between restaurant and dining room.

Shops: 
The generic shop is a building with a cash till. Types of shop are the building with the cash till 
plus the minimum number of items required to describe the type of shop, with a maximum 
of 3. 

Business and organisations:
An organisation or charity has a similarity to a building in that it is a contained shape, but has 
an arch to indicate an over-arching entity. A business is a commercial organisation and has 
money linked to the arch.
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Groups, collections, and subjects:
Brackets are used to indicate ‘about’ in the sense of a group of people or things, or in the 
case of subject, the group of ideas around a theme. 

People and jobs:
People and their jobs are represented by a person plus a relevant illustrative qualifier. The 
plurals of many jobs are available with more than one person rather than using the plural 
qualifier. 

Stick people and non-stick people:
People are generally represented by a stick person being genderless and non-cultural. There 
are times when a fuller figure is needed. This may be to allow emphasis, as in adult or child, 
or for certain actions, such as cuddle - which does not work with stick images. 

Family: 
The circle indicates ‘belonging’. Mother is a woman in a circle (my woman) and wife has a 
heart attached. Girlfriend has the heart but no circle.

Sister and brother are used with grey to draw attention to the target element, with a gender-
less sibling in the circle. Family members from the wider family are represented by a circle 
with people in to indicate a man/woman/boy/girl related to the family. Step relations are 
indicated by a dashed circle.

Pronouns:
There are two types of pronouns illustrated: personal and possessive. 
Personal pronouns: the hand is represented by an arrow head to point to the person. The 
possessive pronoun has a small filled circle to represent the clenched fist. The second person 
‘you’ can be in either singular or plural. 
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Prepositions:
The target is shaded in grey/red. 

Comparatives:
Comparatives are only likely to be used at higher levels of vocabulary. Various alternatives 
have been tried, and the current consensus uses exclamations: one small one for the 
comparative and two for the superlative. The group consensus suggests that this works for 
users who can understand the idea of comparatives, and is ignored by others.

Time:
There was much discussion in the project about the use of hands on the clock. Having hands 
could imply a particular time, but not having hands made the element look either like a mat 
(without numbers) or a timer (with numbers). It was therefore decided by consensus that to 
have a time that was not quickly recognised, (seven minutes to two). Time is normally set in 
relation to the basic clock. 

Tenses:
Past tenses are indicated by a back arrow over the verb and the future by a forward arrow.

Plurals: 
Plurals are indicated by the double plus (similar to more and also). However not all symbol 
readers need the plurals, either because they are confusing or because they can read the 
word and are using the symbol to remind them of the concept. There are options to hide the 
qualifier in the Communicate software. 
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Negatives:
There are a number of common negatives which are normally indicated with a red line, in 
both colour and back and white symbols. (NB the red lines cannot be shown in this black 
and white document). Other negatives are created with the use of one of the three negative 
symbols:

Medical symbols:
The consultants required the possibility of distinction between levels of professionals. For 
example the dentist has a red cross and the dental nurse has a white cross. Symbol readers 
who do not recognise the significance of the colour may not need to understand the 
significance of the role distinction. 

Question words and non-questions:
It is important to distinguish between the use of a word indicating a question and its other 
uses. 

Exclamations:
Black exclamation marks are used for emphasis or degree: For example ‘must’ and 
‘important’.

Other key elements:
Help: the helping hand can be applied to various people or items that help.
The star indicates ‘special’ e.g. special day.
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Non pictorial elements:
Abstract symbols have always posed some problems, and it is questionable whether these are 
needed at the most basic symbol communication. However, where necessary, these have been 
maintained or redesigned along logical lines. It must be accepted that these symbols have to 
be learned. 

Future developments
This is an on-going process and additional schema are developed as the need arises.
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E. Glossary

Arrow-mode (Section B2.2 Choosing the layout of a grid p52)
When working with grids and stages, arrow-mode is used for most purposes other than 
writing into cells. Examples are resizing, linking, editing appearance and moving. Compare 
with text-mode.

Button (Section B6.2 Making a single tray p82)
Specifically within SymWriter a button is like a single cell that can be placed in a tray or 
directly onto a stage. In the documentation the term is underlined to distinguish between 
this meaning of button and more regular uses (like mouse button). 
 
Cell (Section B. Writing with grids p48)
A cell is a single entity within a grid. Usually a cell has a border and is used to contain text 
and symbols that can either be sent to the writing document, or used to perform other 
functions.

Command Graphic (Section B. Writing with grids p48)
A command graphic is an mage that when clicked can send actions to the document.

Document (The window layout p8, Section B3.1 Documents and Environments p63)
The document (or writing window) is the area of the screen where you can type directly into, 
and which can receive input from the grids.

Design-mode (Section B2.1 Starting in Design-mode p51)
This is the normal mode when testing an environment. You can go to test-mode to try the 
activity and return to edit-mode with the stop button on the toolbar.

Environment (Section B3.1 Documents and Environments p63)
The writing window together with any other grids and objects to assist writing is called an 
environment.

Grid (Section B2.2 Choosing the layout of a grid p52)
A grid is a regular array of cells. Cells can be merged in a grid to make it semi-regular.

Home grid (Section B4.2 Making a sequence of linked grids p68)
After loading an environment the home grid is the one which shows before the activity is 
started. It can be set using the context menu for a grid.

Launcher (Section A1. Starting the program p11)
The launcher is a screen containing buttons that appears when the program is started. The 
launcher has buttons that can be used to start the program with a range of configurations.

Leading (Section A3.5 Paragraph alignment, word and line spacing p23)
You can choose to alter the horizontal spacing between words or symbols. Also you can alter 
the spacing between lines, and add extra space between paragraphs. These extra spaces are 
called leading.

Qualifier (Section A2.9 Qualifiers p18)
A symbol may have a qualifier to indicate a plural, a tense, or a comparative or superlative.
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Stack (Section B4.1 Auto linked grids p66)
This is a set of grids or trays on top of one another, occupying the same space on the stage.

Stage (Section B – introduction p48, Section B2. Making a grid p51)
A stage is an area of the screen that can hold grids, trays, buttons and text boxes.

Student (Introduction – Using this guide p7)
The word student will be used to mean the person who uses the grids or the writing tools to 
enable them to have greater literacy access, whatever their age, or educational status.

Teacher (Introduction – Using this guide p7)
The word teacher will be used to mean a teacher, carer or parent who is using the program to 
create and edit activities for others to use.

Test-mode (Section B2.13 Testing a grid p59)
When designing an environment you can go to test-mode (click the Play button) to try it out.

Text box (Section B6.1 What is a tray – overview p82)
A text box is like a single cell that can be placed in a tray or directly onto a stage. It is rather 
like a button, but has different default visual settings.

Text-mode (Section B2.2 Choosing the layout of a grid p52)
When working with grids and stages in the designer, text-mode is used for writing text into 
grid cells. Compare with arrow-mode

Tray (Section B6.1 What is a tray – overview p82)
A tray is a holder for a group of objects such as buttons, text boxes and command graphics.

Wordlist (Section A11.1 Wordlists p43)
A wordlist is a file that can link extra words to images that the symboliser does not produce 
on its own. These are usually for specialised or personal vocabulary.
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Appendix 1 Location of files

This data is provided to assist the network manager or IT coordinator. 

The installer for SymWriter puts files in three areas. These areas are defined by the way 
Windows has been set up either on a stand alone machine or on a network.

1. Program Files area.

On stand alone machine this defaults to C:\Program Files. The SymWriter program files are 
placed in subdirectories \Widgit\Symwriter. In this area is the program itself and the basic 
database used for symbolisation. We will provide updates on our web site and to install these 
you will need to have administrative access to the machine. Generally, other user access will 
not be able to update files in this area.

Key fact: It is necessary to have write access to this area when updating the 
program itself. 

2. The All Users Application Data area.

On a stand alone machine this defaults to C:\Documents and Settings\All Users\Application 
Data. Data for SymWriter is placed in the following subdirectories:

\Widgit\Common Files\Internal Data\ 
	 This contains private data installed by Widgit Software
\Widgit\Common Files\Topic Wordlists
	 Contains any Topic wordlists, see Section A11.2 Loading a Topic wordlist p44
\Widgit\Widgit Pictures

Contains the pictures supplied with the program seen in the Graphic Browser, see 
Section A2.4 Changing the image on a word p14

\Widgit\Widresources
	 Contains the symbol data

When you download or install any low-cost/free Resources  to use with SymWriter these are 
likely to contain Topic wordlists and extra graphic resources. So it will be necessary to have 
write-access to this area to install these. These Resources will not generally need to update 
anything in the Program Files area.

Teachers who want to add Topic wordlists created by In Print 2, will need to navigate to (by 
default):
C:\Documents and Settings\All Users\Application Data\Widgit\ Common Files\Topic Wordlists

Key fact: It is necessary to have write access to this area when installing Resource 
packs for use with SymWriter if those packs contain graphics and/or 
wordlists.
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3. The All Users Documents area

On a stand alone machine this defaults to C:\Documents and Settings\All Users\Documents. 
(Sometimes this will show as “Shared Documents”) Data for SymWriter is placed in the 
following subdirectories:

\Widgit\Symwriter\Interface\ 
This contains interface data created by the teacher to add extra buttons to the 
launcher, or to add other choices of interface. It also contains a file used for extra 
information in the spelling interface.

\Widgit\Symwriter\Environments
This contains the environments and template environments to be used by students and 
shared by students.

When you download or install any low-cost/free Resources to use with SymWriter, these 
are almost certain to contain environments for shared use. So it will be necessary to have 
write-access to this area to install these. These Resources will not generally need to update 
anything in the Program Files area.

Key facts: 
1.	 It is necessary for students to have read access to this area so that they can 

load and use environment files created for shared use.
2.	 It is necessary for teachers to have write access to this area if they wish 

to create environments for others to use. i.e. write access for teachers is 
essential.

3.	 It is necessary to have write access to this area when installing Resource 
packs for use with SymWriter if those packs contain environments (which is 
almost certain).

Documents created with environments are saved into a subdirectory of the My Documents 
area appropriate to the user who is currently logged on.
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Appendix 2 Copyright

Copyright conditions on distribution of materials containing Widgit Literacy 
Symbols (WLS) (formerly known as Widgit Rebus Symbols) or Mayer Johnson 
Picture Communication Symbols (PCS). 

Widgit Software (as a division of Logotron Ltd) is authorised to manage the copyright 
permissions and compliance on behalf of Mayer-Johnson for symbols used within the UK and 
the Republic of Ireland. 

This document refers to the use of symbols from either of the WLS or PCS symbol sets. 

Printed documents (books, materials, leaflets, posters etc).

1. Documents to print where symbols are embedded in third party applications (e.g. PDF,
MSWord and Clicker 5 files).

2. In signage and notices.

3. On Websites, where the symbols are embedded into the web page (i.e. not using
Webwide or other Widgit technology).

Symbols are copyright and cost a great deal to develop and maintain. We therefore have to 
ensure that people who use symbols pay an appropriate amount for their use.

Where the user already has a licence for the symbols, and the files can only be accessed 
through licensed copies of the software, there is no additional charge for the use of the 
symbols. E.g. a file for Communicate: In Print or Boardmaker. Where the symbols are provided 
in a different form, either in print or electronically, including on a website, the customer must 
pay for the use of the symbols.

Small Scale Distribution
This covers distribution within a single authority/organisation, where the distribution is less 
than 500 copies, or the website is specifically created for a local group such as school or 
college.

Where the supplier is an individual, small organisation or small business, the resource 
provider is required to pay Widgit a royalty on the following basis: 

Allowance for non-chargable distribution of documents containing symbols:
A small amount of printed or web based symbol documents may be provided without any 
payment provided the total number of symbols included in ALL resources distributed by the 
organisation does not exceed 100 different symbols. 

The exception to this are resources printed or shared amongst members of the local 
organisation that has purchased the symbol software (e.g. Communicate: In Print or 
Communicate: SymWriter). A single school, day-centre or hospital is regarded as the 
purchasing organisation and not the larger authority such as Local Authority or Health 
Authority e.g. pupils and teachers in a school are regarded as the members and in this 
instance, materials may also be sent home with the pupil. There is no restriction on the 
number of symbols that can be distributed between members of this effective purchasing 
organisation. 
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Widgit does not wish to prevent people with reading difficulties gaining access to materials 
and information, and there may be other circumstances where it is possible to negotiate 
reduced terms or permission to distribute with a zero royalty rate.

Small scale distribution beyond the non-chargable distribution allowance

1. Materials supplied in printed format
the rate is 2p per unique symbol used in the pack.

2. Files that are distributed electronically, (eg as PDF, MsWord)
the rate is 4p per unique symbol. This rate is required whether the pack is sold or
provided free by the creator. There is an allowance for small numbers of symbols that
may be distributed without charge, detailed in the note below.

3. Symbols included in a website
Small scale usage, sites aimed at a local user group or members of a small organisation:
First 100 symbols free, subsequent symbols 12p per symbol.

Larger scale distribution
Where the symbols are included in corporate documents, are for national distribution by 
companies	or	national	organisations,	or	are	for	sale	outside	of	the	not-for-profit	area,	then	
specific	copyright	permission	MUST	be	obtained	through	Widgit	Software.	

Distribution of materials on a larger scale, or by commercially viable organisations, by 
national	organisations,	are	for	sale	outside	of	the	not-for-profit	area	or	where	more	than	
500	copies	of	the	resource	are	likely	to	be	distributed,	needs	specific	approval	with	prices	on	
application.  

Acknowledgement
Each resource, whether free or for sale, must carry an appropriate acknowledgement on each 
separate document or individual sheet that might be used separately, prominently stating 
that the symbols are:

Widgit Literacy Symbols © Widgit Software 2007 (or the current year) plus the web address 
www.widgit.com. 
Or 
PCS symbols © Mayer-Johnson LLC 2007 (or the current year) plus the web address 
www.mayer-johnson.com

[Note: Widgit has changed the name of their symbol set from the Widgit Rebus Symbols to 
Widgit Literacy Symbols. All acknowledgements are required to use the new inscription.]

Registration
All resource providers distributing symbols free or for sale, which falls outside of the 
allowance for non-chargable distribution of documents containing symbols, must register and 
complete an application form available to download from www.widgit.com/copyright or by 
contacting  the copyright team. 

All enquiries on copyright or a paper version of this registration form can be obtained from 
Widgit Software (copyright enquiries)
1st Floor, Bishops House, Artemis Drive, Tachbrook Park, Warwick, CV34 6UD, United Kingdom
or by email from copyright@widgit.com


